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FileHold 15.2.1

1. FILEHOLD 15.2.1 OVERVIEW

This document is a high level description of the new features and enhancements of FileHold
15.2.1.

2. SYSTEM REQUIREMENTS FOR FILEHOLD 15.2.1

The minimum hardware requirements to run FileHold Enterprise or FileHold Express in a
production environment are listed below.

2.1. Application Server Requirements

Windows 2008 R2 Standard and Enterprise Edition Server (64 bit) with 1I1S 7.5

Windows 2012 Standard Edition Server (64 bit) with IS 8
Windows 2012 R2 Standard Edition Server (64 bit) with IIS 8.5
Windows 2012 R2 Data Center Edition with IS 8 (64 bit)

Windows 2016 Standard Edition Server (64 bit)
Windows 2016 Datacenter Edition (64 bit)

2.2. Database Server

SQL Server 2008 (64 hit)

SQL Server 2008 R2 (64 bit)

SQL Server 2008 Express (64 bit)

SQL Server 2012 SP1 (64 bit) Enterprise
SQL Server 2012 SP1 (64 bit) Express
SQL Server 2012 SP1 (64 bit) Standard
SQL Server 2012 SP1 (64 bit) Enterprise Core
SQL Server 2014 (64 bit) Enterprise

SQL Server 2014 (64 bit) Express

SQL Server 2014 (64 bit) Standard

SQL Server 2014 (64 bit) Enterprise Core
SQL Server 2016 (64 bit) Enterprise

SQL Server 2016 (64 bit) Express

SQL Server 2016 (64 bit) Standard

2.3. Web Browser Support

Internet Explorer 11.x (32 bit and 64 bit)
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e Microsoft Edge — current version
e Mozilla Firefox - current version
e Google Chrome - current version

e Safari — current version on Mac

2.4. Active Directory Integration

e Microsoft Office SharePoint Server 2010 (64 bit)
e Microsoft SharePoint Foundation 2010 (64 bit)
e Microsoft Office SharePoint Services 2013 (32 and 64 bit)

2.5. FDA Operating System

e Windows 7 SP1 (32 bit and 64 bit) — Top 3 editions

e Windows 8 and 8.1 (32 bit and 64 bit) — Professional and Enterprise editions. (NOTE: On
Windows 8 operating systems, the .NET Framework 3.5 needs to be installed for Microsoft
Office integration.)

e Windows 10 (32 and 64 bit) Professional and Enterprise editions

2.6. Microsoft Office Support
¢ Microsoft Office Professional 2007 (32 bit) (Outlook, Word, Excel, PowerPoint, Visio) with
SP2 (SP3 recommended)

¢ Microsoft Office Professional 2010 (32 bit) (Outlook, Word, Excel, PowerPoint, Visio,
OneNote)

e Microsoft Office Professional 2013 (32 bit and 64 bit) (Outlook, Word, Excel, PowerPoint,
Visio, OneNote)

¢ Microsoft Office Professional 2016 (32 and 64 bit) (Outlook, Word, Excel, PowerPoint,
Visio, OneNote)

2.7. Microsoft SharePoint Support

e Microsoft Office SharePoint Server 2010 (64 bit)
e WSS 4.0/Microsoft SharePoint Foundation 2010 (64 bit)
e Microsoft Office SharePoint Services 2013 (32 and 64 bit)

2.8. Mobile Platforms Support

e iOS — current version
e Android — current version

The mobile client uses HTML 5 with a small screen size so it is expected that many devices will
work correctly even if they are not officially supported.
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2.9.

WebCap Support

e Internet Explorer 11.x
e Mozilla Firefox — current version
e Google Chrome — current version

NOTE: Only HTTP protocol can be used with WebCap. WebCap does not work with SSL
connections.

2.10. Print to FileHold

e Windows 7 SP1 (32 bit and 64 bit) — Top 3 editions

e Windows 8 and 8.1 (32 bit and 64 bit) — Professional and Enterprise editions
e Windows 10 (32 and 64 bit) - Professional and Enterprise editions

e Windows Server 2008R2

e Windows Server 2012R2

3. NEW FILEHOLD VIEWER

July 2017

The new FileHold viewer replaces the web viewer available in earlier versions of FileHold. It
can display image files (jpg, jpeg, png, bmp, gif, tif, tiff), Microsoft Word (docx), and PDF
documents in both the Web Client and FDA. The FileHold viewer has 2 levels, level 1 and level
2.

The viewers now come standard with the new registered user pricing. When creating a
registered user they will automatically be assigned a level 1 viewer license if one is available.
This can be changed to a level 2 viewer, if purchased. Users will get the use of both the
PDF/Image viewer (FDA only) and the FileHold viewer when assigned a viewer license.
Customers that upgrade will automatically have their PDF/Image viewer and or web viewer
licenses converted to FileHold level 1 viewer licenses.

The FileHold viewer can be used to view documents that exist in the library. It cannot be used
to view documents in the FDA Inbox.

See the table below for features support by the level 1 and level 2 viewers.

Feature Level 1 Level 2

Open multiple documents

Publish document to local computer

Publish document to FileHold

Print document

Copy to the clipboard

x| X| X| X| X| X

Automatically open documents in folders and search results

X X X| X| X| X| X

Basic annotations and markup

If you would like the annotations feature, then level 2 will need to be purchased. The
PDF/Image viewer is still available for use in the FileHold Desktop Application when assigned a

€ FileHold .
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level 1 or level 2 viewer license. Users assigned a Brava viewer license will have access to the

level 2 viewer features.

In the level 1 or level 2 viewer you can print, scroll through pages, zoom in and out, go to next
or previous page, fit to width, best fit, and full size.

& FileHold

Administration Panel  User: sysadm | Help | Log Out

{27 Document Tray
81 Add Document

& My FileHold

& Reviews & Approvals

&2 search

@ (5 Virtual Folders

=B Library

B Accounting

B corporate

Human Resources

Partners
B cualty Assurance
B sales
= [ Training and Support
FileHold 14
= (5P FileHold 15
[ c2roF
[ docs.
B - Administration

C - Gounci, Boards and By-Laws

D - Development and Planning
B pevelopment
B E- Environmental Services

28 Thumbnails <

Creating FastFind Templates

FastFind allows you to search FileHold document management software from third party Microsoft
forms-based applications such as an accounting or ERP system. You create the templates for the third
party application and assign “hot keys” or shortcut keys to search the various areas of the forms-based

1 application. This allows users to quickly search FileHold and access information related to the file they

are working on in the third party application.

Each template can have multiple “sources” and all templates should have multiple “rules” in order to
ensure a good search. For example in an invoice form, sources can be set for the fields, Customer Name,
Customer Number, Amount Owed, Date Billed and Due Date while the rules determine the areas like the
header, body, footer and menu areas of the form to search.

To create a FastFind template

3 Engheering 2 1. Open the third party application that you are creating the template for. In this example, a

e Microsoft Money invoice is used.
A 4 [} - 2. Goto File > Preferences and Settings > FastFind Preferences and select the Enable FastFind <
1® 2017 FileHold Systems Inc. *rilcHold
In the level 2 viewer, the annotations feature allows for different markup types such as
highlighters, lines, arrows, stamps, polygons, rulers, text, and sticky notes.
€3 Creating FastFind Templates - X

HHl Annotations <

4

&
&

[ o

%

[

W B N > O
>

Creating FastFind Templates

FastFind allows you to search FileHold document management software from third party Microsoft
forms-based applications such as an accounting or ERP system. You create the templates for the third
party application and assign “hot keys” or shortcut keys to search the various areas of the forms-based
application. This allows users to quickly search FileHold and access information related to the file they
are working on in the third party application.

Each template can have multiple “sources” and all templates should have multiple “rules” in order to
ensure a good search. For example in an invoice form, sources can be set for the fields, Customer Name,
Customer Number, Amount Owed, Date Billed and Due Date while the rules determine the areas like the
header, body, footer and menu areas of the form to search.

To create a FastFind template

1. Open the third party application that you are creating the template for. In this example, a
Microsoft Money invoice is used.

2. Goto File > Preferences and Settings > FastFind Preferences and select the Enable FastFind
check box. Click OK.

3. Goto Tools > FastFind Templates.

- P e ' A e [

With the FileHold viewer, some features of some of the supported file formats are not
supported for viewing. For example, if viewing docx type files, generally only plain text is
properly rendered. Other items such as tables, images, word art, headers, footers, and
footnotes may be partially shown or not shown at all. Only internal document links work in the
FileHold Viewer. External links, while showing as hyperlinked, do not work. It is recommended

€ FileHold
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that you test your documents in the viewer in order to determine how your documents are
rendered.

4. NEW TECHNOLOGY FOR WEBCAP (PREVIEW)

New technology has allowed us to remove the per server charges for our web scanning
feature, WebCap.

WebCap is a web-based scanning feature that allows remote users to scan documents via a
web browser without the need of scanning software installed except for the TWAIN scanner
driver and the browser connector. Remote users can scan and store documents into the
FileHold repository from anywhere they have access to the internet and a scanner. Note that
WebCap works only with scanners that correctly support the TWAIN driver interface.

WebCap allows pages to be previewed, added, removed, zoomed, de-skewed, rotated,
compressed, replaced, and saved to disk. Documents can be stored in FileHold in multi-page
TIFF or PDF format.

QF"GHOld Administration Panel  User: Renee Sawve | Help | LogOf

& Scanner Inbox
[@ Add Document
@ &g My FieHold
& Reviews & Approvals

Thumbnails < -

& {5 Virtual Folders ®
& B Library [__Invoice Number \ [ lovoics Data__ ™ | Account Number Page
5 B Accountng [oeseors || Femamz || Totd
Billing Address Shipping Address Exprass GST/HST: 121632950
FILE HOLD SYSTEMS INC. FILE HOLD SYSTEMS INC Express OST: 1003874320
B3 2012 HUGH DRAPER DRAPER, HUGH
= b 4664 LOUGHEED HWY SUITE 250 4654 LOUGHEED HWY SUITE 250 Ground GST/HST: 140728450
S 201e BURNABY BC V5E5T5 BURNABY BC V5E 5T Ground 0ST: 1015040583
B3 Atinvoices
EmEe [ S Questions of Address Changes
Human Resources = Phﬂllei 1.800 GoredEx 1.800.463.333%
Pariners Invoice Summary Website:  fodex.ca
[ Qualty Assurance FedEx Express Services FedEx News!
B saies Tra n:pullﬁiﬁn Charges 206.20 Bundle Up for the Playolfs and you could win, Don't miss out.
B Training and Support Fuel Surcharge 2098 Over 1,300 prizes available to be won. Register today at
P TOTAL CAD m fedex.cafplayoffs. l:umes_l closes March B,Zmz._Nu uurchpsa
© ounes oo ey Lo —_ necessary. Some restrictions apply. For ulldeteils and Official
P — 2 Rules, visit fedex.cafplayoffs.
Development
E - Environmental Services e .
B Engineering ey
B F - Finance and Accounting
H - Human Resources
J - Justice
L- Legal Affairs
M - Media and Public Relations
P - Protection and Enforcement St
B R- Recreation and Cutture. 3
B S - Social and Health Care Service
4 » it v -

5. WORKFLOW ENHANCEMENTS

A number of workflow enhancements have been made.

5.1. Automatically restart an approval postponed workflow

If an approval activity has the option to “Allow Postpone Approval” enabled, the workflow can:

e Return to the workflow initiator. The initiator would need to manually restart or re-initiate the
workflow. This was the functionality was available since FileHold 14.

e Automatically return to a previous activity in the workflow template.

Sty 2017 € FileHold ;
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The user postponing the activity can be given an option of selecting from a list of activities
to restart from which includes the returning to the initiator or choose from a list of selected

previous workflow activities.

This feature is useful when a later workflow activity discovers missing information or
documents and needs to return to a previous activity. Participants are notified if a workflow is
restarted and includes the comments of the user who postponed the workflow. If the activity is
1 of X, only the participant who completed the previous task is notified.

Return to workflow initiator (sysadm sysadm

®' Review form submission

Review of the performance review form submitted by the manager by HR team

OK

Cancel

5.2. Convert adocument to PDF during the workflow

Main documents that are going through a workflow process can now:

Be converted to a PDF document at any step of the workflow

Append associated workflow or metadata information as a new page to the end of the PDF
document. Information can be appended to electronic documents, electronic records, and
offline documents. If the document undergoing the workflow is an offline document, then
the offline document is converted to an electronic document and the workflow or metadata
information becomes the document. The appending of workflow information is optional.

A new version of the document is created after the conversion into a PDF.

The following document types can be converted to PDF: docx, doc, dot, docm, dotx, dotm,
html, rtf, txt, and pdf.

If appending associated workflow or metadata information as a new page to the end of a
document, templates using Microsoft Word (docx) will need to be set up. These templates
define the type of information to append such as:

The sign-off sheet from the workflow
Approval date

Workflow name

Workflow template

FileHold ID number

Document version

Version control number

Document control number

Workflow initiator's name

Document owner’s name

Document name

< Hold
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5.3.

5.4.

5.5.

e Any metadata field values

These templates are stored in the FileHold library. The template used can be defined for each
activity where there is a PDF conversion step in the workflow. Multiple templates can be
configured and used in the system.

Convert a document to an electronic record after the workflow is completed

After a workflow is completed, any main documents can be converted into electronic records
automatically. This does not create a new version of the document.

Allow Initiator to Define

Workflow Name * review, approve | | Custom Naming...

supply agreement

Description
4
Used in Schemas Supply Agreement, Bicycle Manuals
#| Initiator can miodify this workflow (add/edit or delete activities) at initiation.
Reset all activities when adding documents to a postponed workflow.
Hide the document version until the workflow is approved '@"
#| Convert main documents to electronic records at completion
! Notify | 2 days and | 0O hours before for tasks that are geing to be overdue.
Email netification I—I I—I
Repeat notification every l:l hours
Observers l:l

Allow document version owner to observe the workflow

The permission setting “Enable converting between electronic documents and records” must
be enabled by a system administrator in order for this feature to work.

Disabling Automatic Refresh for My Tasks List

The automatic refresh of the My Tasks list can now be disabled in the FileHold Desktop
Application. If disabled, the selected task will now remain highlighted until the task is removed
or the focus is moved to another task in the list.

If left enabled, the My Tasks list is refreshed every 15 seconds. The task selection and scroll
position is restored after the refresh and the previous selected task will be lost. This can cause
problems if the user has a large number of tasks assigned to them.

My Workflow Tasks
"M < Submit Approval Submit Review Reserve / Undo Reservation Delegate Tasks View Workflows | Automatic refresh of tasks is disabled
Task Workflow On Behalf of Task Description Initiator Assigned Due Status

Additional “ad-hoc” workflow template settings

The workflow activity settings have been further separated in terms of the “Allow initiator to
define” check box. In previous versions, many of the options were combined into one single
area which is not sufficient granularity for some use cases. The participants list and options are

July 2017 < Hold .
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now separated in the template and each have their own “Allow initiator to define” check box

option.

Workflow Activity 1

Title

Description

Reviewers *

Options

Due By *

Task Instructions

Basie Pie, Deborah Dixen, Renee Sauve, sysadm

) Include document version owner
L Include workflow initiator

) 10fx

) Force reservation

¥ sllow Check Out
Require password

) cenvert main decuments to PDF

5 days and |0 hours after werkflow initiation

Please review and pass on for approval

6. COURIER ENHANCEMENT

[Reve—— v][1 v]©

=

Courier can now use the new FileHold viewer to view documents in the Courier portal. There is
an option to “view” the document if the format is supported (jpg, jpeg, png, bmp, gif, tif, tiff,

docx, and pdf).

Couriern

basiepie1@gmail.com My account ~ Logout

sysadm wants you to approve 1 documents

Sender
Date sent
View by

Transmission number

sysadm
27-01-2017
29-01-2017

2e6C¢7760-6470-42ab-b35a-1c0b7275¢d37

FileHold Courier

The following 1 documents require your approval. You must view or download all documents before you will have the

option to approve.

Document name

Type of File

Invoice # 10398 Save-a-lot Markets 09-Jan-1997 PDF

—— —

Courier, powered by FileHold

Action Prod ID

©

A View button will appear for any supported document format. There is no configuration
required to make the viewer work with Courier. The viewer will open the document in a
separate pane. In the viewer you can scroll through pages, zoom in and out, fit width, fit length

or whole page.

€ FileHold
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C our i ern FileHold Courier

B8 Thumbnails <

Creating FastFind Templates

FastFind allows you to search FileHold document management software from third party Microsoft
forms-based applications such as an accounting or ERP system. You create the templates for the third
party application and assign “hot keys” or shortcut keys to search the various areas of the forms-based
application. This allows users to quickly search FileHold and access information related to the file they
are working on in the third party application

n

Each template can have multiple “sources” and all templates should have multiple “rules” in order to
ensure a good search. For example in an invoice form, sources can be set for the fields, Customer Name,
Customer Number, Amount Owed, Date Billed and Due Date while the rules determine the areas like the
header, body, footer and menu areas of the form to search.

m

To create a FastFind template

1. Open the third party application that you are creating the template for. In this example, a
Microsoft Money invoice is used.

2. Go toFile > Preferences and Settings > FastFind Preferences and select the Enable FastFind
check box. Click OK.

3. Go to Tools > FastFind Templates.

4. In the list of FastFind Templates window, click Add Template.

2 5. The message “Activate the window you want the FastFind Template to be associated with and
press Alt+N.” appears. Select the third party application and type Alt+N.

6. A “snapshot” of the application will now appear in the FastFind Template window, If the
incorrect window was invoked, click Select New Window and repeat step 5.

e e [re— =
R
e -
o m
St 11,047 \fjmw or edit an existing invoice: Accounts Receiva
- e o n :

7. FASTFIND ENHANCEMENT

FastFind searches can now be based on a quick search or a full text search (file and metadata
search). If based on a quick search, it will only search on that specific search parameter and
nothing else in the system (unlike a full text search which will search everything). Advantages
of using up a quick search with FastFind would be to be able to limit the search results. For
example, if FastFind was only used to locate an invoice in FileHold from your accounting
software, the search results would be limited to what documents would be found using “Invoice
Number” quick search.

July 2017 Q FileHOld 9
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My FastFind Preferences ? *
Enable FastFind [] Update FastFind templates when I log in to FileHold
Enable mouse search Alt+5
Enable selection search Cirl+D
Enable Clipboard search Alt+C

Enable screen OCR search Alt+F

Search using:] () File and metadata

® Quick search  |Invoice # | III

Shortcut Summary

Name Description Last Modified Date Last Modified By

0K Cancel Apply

8. SMARTSOFT CAPTURE LICENSING ENHANCEMENT

SmartSoft Capture licenses can now be run concurrently by any number of users. There is no
restriction to the number of workstations Capture can be installed on, but the concurrent use of
Capture cannot exceed the total number of single copies purchased by the customer. For
example, if the customer purchases 5 copies of Capture and installs the software on 20
workstations, 5 users can simultaneously run Capture. If the sixth person attempts to run
Capture, they will be told they are not licensed.

A timeout value can also be set for Capture licenses so that users are automatically logged out
of Capture after a period of inactivity so an idle session can be freed up for another user.

The number of Capture licenses can be viewed in the licensing and users page.

Licence Details ‘

Registered to

License issued 1/24/2017, 9:27 AM
License time limit unlimited ‘
Description
Concurrent Sessions 100
Available Courier use units 0
Registered Users 100
Guest concurrent sessions 100
[ Capture concurrent sessions 3
Sharepoint client concurrent sessions enabled

Workflow module enabled

10 € FileHold July 2017
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9. MISCELLANEOUS ENHANCEMENTS

9.1.

9.2.

9.3.

Document URL enhancement

Direct download will automatically download the document without showing the document in
the viewer OR show all supported file formats in the viewer (such as PDF file) and download
any unsupported viewer file formats (such as Microsoft Word, Excel). There is a setting that
can be configured in the web config file in C:\Program Files\FileHold Systems\Application
Server\WebClient that configures this option. If set to false (default) then supported documents
are displayed in the viewer and the remaining unsupported file types are downloaded. If set to
true, then all documents are automatically downloaded without viewing.

<add key="ViewerFormAlwaysDownloadDefault" value="false" />
This can also be done on the fly in an HTTP parameter.

Adding middle initials to registered user names

In order to see the full name and middle initial of users in the logs, users page, group

members, and metadata pane, a web config file can be modified and a tool run in FHIT. This
feature is useful when you have users with same first and last names.

Restructuring of the Administration Panel

The following image shows how some settings have been moved and/or renamed in the web
client administration panel.
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9.4. Invalid certificate errors in the FDA

Workflow management

Library management

System management

Import jobs
OCR queue status
Full text search
License information

Administration reports
System configuration

General
Search

Document viewers

Security

Logon

Self registration
Document repository locations
Client options
Alert Preferences
Workflow Preferences
FastFind Preferences
Misc Preferences
FDA Advanced Settings
Advanced Search Options
Library configuration

General
Workflow @
Document schemas

Metadata fields
Control fields
Events

Workflow templates
Courier templates

Extraction rules

If there is a certificate name error in the FDA, the user is now prompted to remedy the issue. A
message, “We cannot verify the secure connection to your FileHold server. Contact your
FileHold server administrator to correct this situation.”
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The system administrator is then provided additional information about the server and the
security certificate. The system administrator then has the option to bypass the error one time
or always ignore.

An option in FHIT > FDA Configuration can be enabled to never ignore certificate name
mismatch errors when creating FDA installation templates.

9.5. Group restrictions for Read-only and Guest roles

The download and printing restrictions for read-only or guest role groups have been separated
into their own options.

Group Mame * ‘ Guest Users |

Description ‘ |

Role* @ [ GuestUser v
Notes

FileHold Group Members Display all members in one page

Name Source
8 Guest User Local
8 Web Portal Guest Local

Add Members

Disable emailing documents
| =V Disable download (open, local copy)

(x]x]

Restrictions

Disable printing

0K H Cancel || Apply ‘

9.6. Full text search

Full text indexing has been improved to be resistant to real time diagnostic and malware
utilities locking files when indexing is attempted. The full text search status report, health
checker report, and full text search status page has been updated to include information about:

e The number of documents in the FTS queue with failed index attempts in the FTS status
screen and FTS status report.

e Number of documents that required more than one attempt to add to index in the health
checker and FTS status report.

e Number of documents with unsuccessful attempts to add a document to the index in the
health checker report.

There are some options that are configurable for the FTS index in a web configuration file. The
web.config file can be found in C:\Program Files\FileHold Systems\Application
Server\FullTextSearch:

e Add2IndexEnableVerify — Checks to see if the doc is in the index. The default value
is 1 which is enabled. If set to 0 then it is disabled. It is recommended that you keep this
setting enabled. There is a small performance penalty to make this check.

e Add2IndexMaximumRetries — The number of times that the document will attempted to
be indexed. Default value is 10 minutes

e Add2IndexDays2RetainFailures — The length of time that a document will sit in the
FTS queue if it has not been successfully indexed. Default value is 750 days.

July 2017 ‘ HOld
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10.RESOLVED ISSUES

ID Title

8273 Slow response time when clicking the ‘Show documents’ link in the My Tasks list
or Workflow Status report for large (over two million) document libraries.

8276 Changes in the document name and/or version control no. fields of a doc are not
shown as values under the 'Metadata field changes' column in the document
usage log.

8277 Cannot reinstate as latest version for a doc associated with a version control field
in a specific scenario.

8289 Cannot sort the list in the Check-in Files to the Library window by '‘Document
Name'.

8290 System does not automatically disable a registered user who was disabled from
the domain after running the FH AD synchronization task.

8291 (FDA) Freezes after opening My Tasks several times for very long lists of open
tasks.

8298 Incorrect permissions stated for a user who is a member of ‘System Admin’ or
‘Senior Lib Admin’ in the Effective permission report in a specific scenario.

8301 Incorrect value for a user's group membership found in the Effective permissions
report in a specific scenario.

8302 AD group user not added to FileHold group.

8304 Missing entry of deleted users belonging to a domain group in the System audit
log.

8315 (FDA) Cannot open document in Brava or PDF/Image viewer when in the Library
Archive.

8317 Health Checker takes a long time to run on large libraries.

8328 (FDA) Enabling & performing a mouse search (Alt+S) using FastFind causes
error.

8345 Incorrect message in the document usage log after re-adding a domain user
previously deleted from FileHold.

8385 Missing Last login date for some user(s) in the List of all FileHold users.

8391 (Courier) Downloading a file with a size of more than 770 MB from the Courier
portal throws an exception.

8402 Strange characters appear as the 'Library location' search filter upon
setting/viewing an empty saved search.

8407 (FDA) Shared import file(s) cannot be seen by a second user whose user
preference was set to a "document import format" different from the first user.

8486 User checkboxes found in the List of all FileHold users were not cleared after
adding multiple users to a FileHold group.

8487 Issues with scheduled tasks settings on server and their run time on a Windows

Server 2016 upon installation.

14

HOld July 2017




Release Guide FileHold 15.2.1

ID Title

8508 UserRoleManager port number not updated by FHIT.

8516 Cannot delete an 'auto-start' workflow template after deleting its associated
schema.

8519 Adobe Reader removes and recreates files causing the FDA to lose its tracking
information.

8551 No email notification upon completion of a workflow when not approved in a
specific case.

8573 (FDA) Watched folders upload empty files in when server is slow to complete a
login.

8578 (WebClient) Missing 'pie chart' in the Workflow Dashboard.

8610 Active Directory domain synchronization error.

8622 Date/time format issue in the event viewer and event notifications for certain

regions.

11. KNOWN ISSUES

ID Title

5084 FileHold Office Client issue related to a Microsoft Excel Object embedded on a Word
document. This is a known Microsoft issue:
http://social.msdn.microsoft.com/Forums/en-US/vsto/thread/0854a0f0-cf7f-4837-9471-
82de3fa63177/

6008 When a date format is set to 'yyyy-MM' the date can by entered directly without the
hyphen, but the value is ambiguous and may be interpreted correctly.

6455 (Mobile Web Client) Strange behavior when taking picture to add as regular
documents or review/approval feedback document (iPhone-5 with i0S-7).

6603 (FDA) Sometimes FastFind selection search (CTRL+D) needs to be invoked twice to
work.

6901 (Web Viewer) Issue rendering thumbnails when viewing a document with a large
number of pages.

7802 SQL timeout occurs when users are checking the "Email notify all folder members..."
option upon adding files to a folder when the FH email server is not correctly
configured.

7948 (ADI) Inconsistent behavior with matching values in a dropdown metadata field using
the indirect metadata import related to leading or trailing spaces in dropdown values.

8221 A small amount of new text cannot be translated in a language pack.

8319 Improve the reliability of FH service account validation with respect to the relevant
local server settings or domain policies in the Pre-installation HealthChecker.

8348 "TWAIN web connector not found" warning message prompts user upon opening the
Scanner Inbox preview in Edge or Chrome.

8361 (Web Client) Pressing Enter when adding a drawer to a cabinet does not save the

drawer.
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ID Title

8387 (Server updater) FileHold scheduled tasks were not created after upgrading a FH15.1
to 15.215.2.1 on a Windows Server 2016.

8403 (FOC) “Add file” operation menu items are disabled on MS Outlook 2016 after
successfully logging on to the FDA in certain scenario.

8498 Failed to extract value(s) from a metadata field name containing special character(s)
when converting a document to a pdf during a workflow.

8515 (FDA) You cannot sort by 'User type' column found in the Administration menu > User
management > Users list.

8526 Incomplete hardware key value showing up in the text area when requesting a license
file in some FileHold 15.215.2.1 installs on Windows Server 2016. See the
Supplemental Installation Guide on how to fix this issue.

8530 (FDA) Word table not correctly formatted in Brava viewer.

8531 (SharePoint WebParts) integrated authentication does not work on SharePoint 2013.

8533 (FHIT) Cannot logon to the AD synchronization tool of a FH server configured only for
HTTPS.

8535 (FDA) Inline edit of drop down fields does not work correctly.

8536 (ADI) Loading document details is slow when the list of imported documents is allow to
grow very large before clearing.

8540 (FDA) Cannot enable the print function for a user who is a member of the "Read only"
FH group.

8543 (FOC) Cannot attach a document from the Library Archive to an Outlook message.

8555 The user sessions log may have orphaned sessions after the system is upgraded or
moved while there were active sessions.

8557 URL fields do not appear as links in finished document when converting a document to
a PDF during a workflow.

8560 A non-administrative user cannot see the latest version of a document in a workflow
they previously initiated when the document was marked as 'approval postponed'.

8576 Several issues found when performing multi-selection of menu items from a drop-
down metadata field list.

8577 Mass edit is disabled for documents in a workflow.

8578 Workflow dashboard does not display on Windows server 2016 systems by default.

8586 Cannot search for a file associated with a Currency or a Number metadata field with
decimal place in a specific scenario.

8668 (FHIT) Exception thrown when attempting to export library configuration with public

saved search(es) configured with 'Contains In DB' as search operator.
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